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Important Information                         

 

�³ �³Thank you for purchasing the Expert 52 LX Cutting Plotter.  

Before you use the cutting plotter, please make sure that you have read the �³ �³ �³ 

safety precautions and instructions below.  

              Caution

!

SAFETY PRECAUTIONS!  
�  For safety concern, please always hold the cutter firmly from the bottom  while moving 

it.  Do not move the cutter by clasping the depression area on both sides.  

 

                        

 

 

  

�  Do not shake or drop the blade holder, a blade tip can fly out.  

�  During an operation, do not touch any of the moving parts of this machine (such as the 

carriage). Also be careful to make sure that clothing and hair do not get caught.  

�  Always connect the power cable to a grounded outlet.  

�  Always use the accessory power cable which is provided. Do not wire the power cable 

so that it becomes bent or caught between objects.  

�  Do not connect the power cable to branching outlet to which other machines are also  

     connected, or use an extension cable. There is danger of overheating and of  

      mis-operation of the machine.  

�  Keep the tools away from children where they can reach.  

�  Always put the pinch rollers within the white marks.  

 

���������	��
�������� 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 		 	 	 	 	 	

O  (correct)   � X  (Incorrect)   
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1.1 Package Items 

The package of Expert 52 LX contents the items listed below, please check carefully.  

If you find any item missing, please consult your local dealer for further assistance.  

 
 
1.2 Product Features  

The followings are the main features of the Expert 52 LX cutting plotters: 
        �˜  Dual-port connectivity – USB & Serial interface. 

�˜  Up to 250 gram cutting force.  

�˜�³ Up to 400 mm/per second cutting speed. 

�˜�³ Guaranty 3 meter (10’) tracking. 

�˜�³ Enhanced Automatic-Aligning System (AAS II) for auto contour cutting. 

  

 

 

 

 

 

 
 

 Item Quantity 
 Cutting Plotter 1 Set 
 Accessories 1 Set 
1. Installation CD 2. AC Power Cord 4. Cutting Pad 

 

 

 

4. USB Cable (1.8m) 5. Paper Slicer 6. Tweezers 
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1.3 The Appearance (EX-52 LX) 
1.3.1 The Front View  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Object Description 

A Primary Pinch Roller To help hold the media during cutting. 

B Slicing Groove To help slice off media. 

C Alignment Ruler To align media with clear guideline marks 

D Tool Carriage Performs the cutting with the installed blade or pen.  

E Blade Holder To hold the blade. 

F Platen The surface for holding and supporting media in operation. 

G Cutting Pad To protect blade and plate in operation.    

H Control Panel  To consist of 10 control keys and 6 LED lights. 

J Grid Drum To move media back and forth in operation 

Figure 1-1 

J 

Figure 1-2 
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1.3.3 The Side Views  

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Object Description 
K AC Power Connector To insert the AC power cord. 
L Fuse 3Amp. 
M Power Switch To turn on or off the machine. 
N USB Connector To connect the machine and a computer through a 

USB cable. 
O Serial Interface Connector To connect the machine and a computer through a 

RS-232 cable. 

K L M 

Figure 1-3  Figure 1-4 

N O 
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2.1   Precaution 

  Please read below information carefully before you start installation.  

 
Notice 1  

�  Make sure the power switch is off before installing the cutting plotter.  

�  Carefully handle the cutter to prevent any injuries. 

 

Notice 2   Choosing a proper place before setting up the cutti ng plotter  

Before installing your cutting plotter, select a suitable location, which meets the following 

conditions. 

�  The machine can be approached easily from any direction. 

�  Keep enough space for the machine, accessories and supplies. 

�  Keep the working area stable, avoiding severe vibration. 

�  Keep the temperature between 15 and 30 �:�:�:�:  (60-86oF) in the workshop. 

�  Keep the relative humidity between 25% and 75% in the workshop. 

�  Protecting the machine from dust and strong air current. 

�  Preventing the machine from direct sunlight or extremely bright lighting.  

 

Notice 3   Connecting the Power Supply  

Check the plug of the power cord to see if it mates with the wall outlet. If not, please contact 

your dealer. 

�  Insert the plug (male) into a grounded power outlet. 

�  Insert the other end (female) of power cord into the AC connector of cutting plotter. 

 
 

��������		��
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2.2   Stand Installation 
 

2.2.1  Stand Installation 

Please follow the procedures below for assembling the stand. 

 

Step 1  Please examine the supplied items in the accessory box of the stand carton 

before you install:  
Stand is an optional item for Expert 52 LX, Item Li st �š�š�š�š  

�  1 Left side vertical stand 

�  1 Right side vertical stand 

�  1 Support for left side 

�  1 Support for right side 

�  1 Stand Beam 

�   2 Bottom Stands with wheels 

�   2 Sliding brackets for paper take up 

�   1 Hex Wrench (M5)� 4 

�   28 Socket flat head screws(M6*12L) 

�   1 Installation Guide 

 

 

Step 2  

Position the Left side vertical stand perpendicularly to part � and put the screws into the 
holes and tighten them to form a left side T-stand (Figure 2-1). Repeat the same steps with the 

Right side vertical stand.  

 

 

 

Left side vertical stand 

�  Bottom Stand 

Figure 2-1 
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Step 3  

Place the stand beam upright on the T-stand and put the screws into the holes but do not 

tighten them at this step.   

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Step 4  

Remove the cutting plotter from the carton. Position the stand under the plotter, and insert the 

screws into the holes on the bottom of the plotter and tighten them up as shown in Figure 2-3.  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

T-stand 

Stand Beam 

Figure 2-2 

Figure 2-3 
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Step 5 

Insert the roll holder support with the screws into the holes of the stand, and then tighten them 

up as shown in Figure 2-4. You could decide roll holder support’s position by inserting into 

different holes. 

 
 
Step 6 

Place two roll holders onto the roll holder support and ensure the white protrusion is wedged 

in the groove. (Figure 2-5)  

 

Roll holder support  

3 screws 

Figure 2-4 

Roll holder support 

Roll holder 1 

Figure 2-5 

Roll holder 2 
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Step 7 

Turn the screw counter-clockwisely for around three times after unpacking roll holder 2 

 
 

Step 8 

Insert the end of the roll holder without the damper into the left roll holder support and then 

insert the end of the roll holder with the damper into the right roll holder support. Ensure the 

white protrusion is wedged in the groove. 
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Step 9 

Tighten the screw on the damper until it is securely attached to the right roll holder support. 

 

 

Step 10 

Lastly, the complete picture will be shown like below. (Figure 2-6) 

 

 
 

Figure 2-6  
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Figure 2-7 

 Pin 

Outward ring  

Adjustment depth knob 

2.3 Blade Installation 
 
Figure 2-7 is the illustrator of the blade  

holder. Insert a blade into the bottom of  

the blade holder and remove the blade by 

pushing the pin. Make sure that your fingers  

are away from the blade tip.  

 

 

 

 

 

Step 1                                   Step 2 

Install blade (Figure 2-8).                   Push the blade to the bottom of the blade  

 holder (Figure 2-9).  

 

 

 

 

 

 

 

 

 

 

Step 3  

Adjust the blade tip to suitable length by  

screwing “Blade tip adjustment screw”  

clockwise or count-clockwise. (Figure 2-10).  

 

 

 

 

 

 

 

 

 

 

 

Tips: 

“The proper length” means the blade’s 

length is adjusted 0.1mm more than film’s 

thickness. That is, if the thickness of film is 

0.5mm, then blade’s length is properly 

adjusted 0.6mm and it can completely cut 

through the film layer yet avoid penetrating 

the backing. 

Figure 2-9 

Figure 2 -10 

Figure 2-8 
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Step 4  

Insert the blade holder into tool carriage. Please note the outward ring of the holder must put 

into the grooves of carriage firmly (see Figure 2-11), fasten the case (Figure 2-12).  

                    

 

 

 

 

 

 

 

 

Figure 2-11                             Figure 2-12   

 

Step 5   

Use the reversing steps to remove the blade holder. 

 

 

Step 6   

Eject the blade: Push “Blade eject pin”  to eject blade when the blade needs to be replaced.   

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 

Caution  

The blade will lose its sharpness after a period of usage, the cutting quality might 

be affected. By increasing the cutting force, it might do the trick. However, once 

the blade is worn out and no longer provides a reliable cutting, you should replace 

a new one. The blade is consumable and must be replaced as often as necessary 

to maintain the cutting quality. The quality of the blade deeply affects cutting 

quality. So be sure to use a high quality blade to ensure good cutting results.

 

Tips - When to replace a new blade: 

�  If the blade is broken, you have to replace a new one. 

�  If cutting quality is not as good as usual, you may need to replace a new 

one. 

�  If the material cannot be cut through by higher cutting force, you may need 

to replace a new one.  
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2.4 Instruction of Damper Roller 
 

Turn the wheel as instructed below to adjust damping. The bigger the number is, the stronger 

the damping. The volume symbol sticker indicates the damping level, shown below. 
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Figure 2-13 

Figure 2-15 

Figure 2-16 

Figure 2-14 

 
2.5 Media Loading 
 

2.5.1 Loading the Sheet Media 

To load the media properly, please follow the 

procedures below: 

 

Step 1   

Lift the 2 levers at the back side of the cutter to lift the 

pinch rollers (Figure 2-13). 

 

 

Step 2  

Load your media on the platen and slide it under 

the pinch rollers from either the front side or the 

backside. The alignment rulers on the platen 

extension will help you to adjust the media 

precisely (Figure 2-14). 
   

 

 

Step 3  

Then move the pinch rollers manually to the proper position. Be sure the pinch rollers must be 

positioned above the grid drum. The stickers  on the main beam show the position of the grid 

drums (Figure 2-15).   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Stickers 
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CAUTION! !! 

�  Make sure the Primary and secondary pinch rollers are set to right positions. 

�  Position the Primary Pinch Rollers at the right and left sides of media. 

�  Position the Secondary Pinch Roller at the center of media.    

Note: Expert 24 serves as an illustrator here.   

 

 

 

 

 

 

Primary Pinch Roller  

Figure 2-17 

(X) 

Incorrect  

(O) 

Correct 

Secondary Pinch Roller 

Figure 2-18 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 4  

Push the lever backward to lower down the pinch rollers (Figure 2-16). 

 

Step 5  

After turn on the power, the tool carriage will measure the size of the media automatically. And 

the plotting cutter begins to work. 
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Figure 2-19                       Figure 2-20 

(O)       (X) 

Correct                Incorrect    

 

2.5.2 Loading the Roll Media  

 

You can use the stand. Please refer to Chapter 2.2 for hardware setup, and Chapter 2.5.1 for 

media loading. 

 

 

2.5.3 How to change the poll size without turning o ff the machine? 

 

Have the machine on-line, press origin set once and the red error light will start blinking, then 

pressed again and the machine will start moving to get the new size. Then open the VLCD 

and under the poll size you will find the new measurements. 

 

 

 

 

 

 

 

 

Note: 

�  Always adjust the position with the pinch rollers raised. 

�  Please reposition the pinch roller by holding the center of the pinch roller and moving it 

from the rear end of the machine. (Figure 2-19) 

�  DO NOT move the pinch roller by holding its front rubber roller (Figure 2-20).   
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2.6 Cable Connection 
 

The cutting plotter communicates with a computer through a USB (Universal Serial Bus) or a Serial 

port  (RS-232C). This chapter shows you how to connect the cutting plotter to a host computer and 

how to set up the computer/cutting plotter interconnection. 

 

!! Notice:  When USB connection is enabled, serial port will be disabled automatically.  

 

 
2.6.1 USB Interface 

Expert 52 LX build-in USB interface are based on the Universal Serial Bus Specifications 

Revision 1.1. (Operation system of Windows 95, Windows NT don’t support USB ).  

 

�  USB driver installation 

 

 

 

Use the USB One-click Installation for quick driver installation. Follow the simple steps 

below for driver setup. 

 

Step 1:   

Connecting your GCC cutter 

1. Turn on the machine. 

2. Connect the USB connector to the machine and then USB driver will installed 

automatically. It will take a few minutes to find the device. Please DO NOT disconnect 

the USB cable until the installation has completed.  

3. You can double click the USB icon on the taskbar to make sure the USB device is 

detected. 

 

 

Caution!!  

�  If you are using Windows 8/ 7/ Vista/ XP/ 2000 as y our operating system, 

make sure you log in using the “Administrator” acco unt. 
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Step 2:  Installing the software 

(1) Put the installation CD into your CD-ROM. Please make sure that the USB device is 

connected before you start the driver installation.  

 

(2) Choose the model you want to install from the driver list and click on Win 8/ 7/ Vista/ 

XP Driver (Manual Selection) or Win 8/ 7/ Vista/ XP Driver (Automatic detection) to 

start installing the Driver and AAS plugin. (The Expert Pro model is used as an 

illustration in the following steps.) 

 

 
 

(3) Click “Next” to start the driver installation. 
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(4) The installation will take a few minutes to complete and you will see a message below 

and click on “OK” upon completion. Enjoy your GCC cutter! 

 

 

 

 
 

Note: 

(1) If the driver is being installed for a second time, the user will be prompted as to whether a 

second copy of the driver installation is required. 

 

 

(2) If the user selects yes, a second copy of the driver will be installed. 

    
 

 

For users who have upgraded Adobe 

Illustrator or CorelDRAW, please go 

to the AAS Installer page in the 

Properties window and click Install to 

access the latest version of GCC 

AAS Plugin. 
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2.7.2 Driver Un-installation 

 

You have to remove previous version driver installed on your PC system completely before 

you can install the latest version successfully. Please refer to below steps.  

 

1. Right click on the printer to remove the printer from system Printer page.  
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2. After removing the unit, right click on any empty space on the page and select “Server 

Property” 

 
 

3. Select “Driver” page 
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Select the model and click on “Remove”. 

 

 

Click on “OK” 

 
Click on “Yes” 

The driver installed on PC is completely removed. 
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2.7.3 RS-232 Interface 

 

�  Connecting to the RS-232 (Serial) Port 

For IBM PC, PS/2 users or compatibles, connect the RS-232C cable to the serial connector of 

the assigned serial port (COM1 or COM2) of your host computer.  

 
2.7.4 Printer Sever Shared Setting 

 

In “A-PC”, set the printer driver as a shared printer, then use B-PC to connect A-PC’s printer 

driver via internet. 

 

������ � � � � � � � � � � �����

�

�

�

�

�

�

�

�

�

�

�

Step 1. 

Please set A-PC’s printer driver to shared printer. (Right-click on printer icon, choose “Printer 

properties”. Click “Sharing” tab then check “Share this printer”) 

� � �

��������  

�����	
����
 �
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�

Step 2. 

Click “Advanced” tab, then choose “Print directly to the printer” option. 

 
 

 

 

Step 3. 

Send a job to the machine to check if A-PC is connected to the machine. 

 

 

�

�

�

�

�

�

�

�

�

�

�

�

����
�������������
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�

Step 4. 

Activate A-PC’s Printer Driver from B-PC’s Network. 

 

 

Step 5.  

Right-click on printer icon, and select “Connect” to connect A-PC’s printer. 
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3.1 The Control Panel 
  
3.1.1 The Outline of control panel 

 

 

 

 

 

 

 

 

Key Function 

POWER LED To indicate the power status ( light up: power on; light off: power off ) 

ERROR LED To indicate the error status ( light up: error; light off: normal ) 

ON/OFF LINE 

To switch modes or stop cutting job( light up: on-line; light off: off-line ) 

While in on-line mode: only ON/OFF LINE and PAUSE keys activated 

While in off-line mode: the settings in VLCD can be adjusted.  

PAUSE To temporarily halt cutting process or to continue 

REPEAT To repeat last job. 

DATA CLEAR  To clear up buffer memory. 

CUT TEST To perform cutting tests on different media. 

ORIGIN SET  To reset origin at a new position.  

4 Arrow Keys To move carriage position, select function, or change setting. 

 

3.1.2 Reset Origin 

 

 

 

 

Step 1   Move the carriage to a new position. 

 

Step 2   Press the ORIGIN SET button to reset origin.  

��������	
��� � � � � � � � � � � � � � � � � � � � � � � �

Figure 3-1 

Note: 

�  Make sure the machine is in off-line mode to enable this function.  
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3.1.3 Cut Test 

  

 

 

 

 

 

Step 1  After sizing, press the ON/OFF LINE button to set as off-line mode. 

 

Step 2  Move the carriage to a preferred position. 

 

Step 3  Press CUT TEST button to perform. 

 

3.1.4 Repeat  

 

 

 

 

Step 1  Press the ON/OFF LINE button to set as off-line mode. 

 

Step 2  Press the REPEAT button to perform re-plot function starting at the position where  

        the carriage locates. It is also available to move carriage to a preferred position,   

re-set origin, and then perform this function.    

 

3.1.5 Repeat AAS Job 

This feature allows users to repeat AAS jobs automatically without having to operate on the 

computer side. 
 

Step 1  When the first AAS job finishes, press “Repeat” on the control panel to activate this 

function. 

 
 

 

 

 
 
 
 

Note: 

�  Make sure the machine is in off-line mode to enable this function.  

�  It’s recommended to keep performing this function until the cutting 

quality meets your demand before executing the cutting job. 

Note: 

�  Make sure the machine is in off-line mode to enable this function.  

Note: 

�  Please be noted that this feature is mainly applied to the Single paper 

mode; ensure a new piece of material is loaded and the origin 

repositioned to the first registration mark before “Repeat” is pressed. 
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Figure 3-3 Figure 3-2 

3.2 VLCD 
    “VLCD” is a computer program to help modify parameters of cutting functions. 

  
3.2.1 Installation 

Step 1  Copy the VLCD.exe file in the Accessories folder of the Expert 52 LX Installation CD 

onto your local drive to finish installation.  

 

Step 2  Launch VLCD by double-click on the icon.  

 

 

 

 

Step 3  Choose the right port connected to your computer (Figure 3-2).  

If you are using the USB cable, choose USB0 from the pull down menu. If you are 

using a Serial cable, choose either COM1 or COM2. Make sure no other devices 

are occupying the port that you are going to use. 

 

Step 4  Press the Connect  button to connect your computer and the cutter. If the 

connection succeeds, the model info, firmware version, and adjustable parameter 

columns will be showing (Figure 3-3). 

   

   

 

 

Note: 

�  Make sure the machine is in on-line mode to enable this program.  

�  There is media in the machine. 
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Figure 3-4 

3.2.2 Functions of VLCD 

 

Below are the functions adjustable in VLCD for Expert 52 LX.  

�  Poll Size 

�  Force 

�  Media Weight 

�  Offset 

�  AAS Offset 

�  Auto Unroll 

�  Update Setting 

 

 

 

�  Poll Size 
Click on the Poll Size  button will reveal the X/Y values.  

 

In the case, the maximum plotting length is 25000mm, 

and the distance between the farthest two pinch 

rollers is 568.85mm (Figure 3-4). 

 

 

 

 

 

 

 

 

 

 

 

 

 

�  Force 
To adjust the blade force between 0 and 250 (Default = 50).  

 

�  Media Weight 
To choose different weights of media in two options: Heavy, and Light (Default).  
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�  Offset 
To adjust the blade offset to ensure cutting quality in 8 options: 0.000, 0.175, 0.250(Default), 

0.275, 0.300, 0.500, 0.750, and 1.000.  

 

 

�  AAS Offset 
 
To set or modify AAS offset value. 
You can refer to “5.3 Printer Test” for more details. 

 

 

 

�  Auto Unroll 
To switch options for sheet media and roll media (Auto Unroll On: Default). 

 

�  Update Setting 
To apply the changed setting onto the cutter by presses the Update Setting  button. 
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3.2.3  

Restore factory default settings 

VLCD allows you to turn all parameters to factory-default settings. 

 

Step 1 Enter the USB-port switching mode by pressing “Pause”(2) after “On/Off line”(1) and 

then press “Origin Set” (3). 

 

 

 

 

 

Step 2 Press the left key (4) and then up (5) 

 

 

Step 3 You have now entered the Data clear and restoring default settings mode; press “Data 

clear” (6) and then “Origin Set” (7) to confirm. 

 

 

Step 4 The default settings restoring process has been completed. All buttons will be ineffective 

before the cutter is rebooted. 

 
 

Step 5 Restart your cutting plotter now. 
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3.3 File Uploader 
 

3.3.1 Installation 

�  “File Uploader” is a tool to help loading files for direct output. 

�  The program ONLY supports HPGL format-files generated via GCC Cutter driver. 

�  Copy the GCC File Uploader.exe file in the Accessories folder of the Expert 52 

LX’s Installation CD onto your local drive to finish installation.  

�  Launch GCC File Uploader by double-click on the icon (Figure 3-5). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.3.2 Functions of File Uploader  

 

�  Port setup 
�  This function will be activated while choosing COM port for data transmission. 

�  Press the Port setup button to pop up the setup window for parameter change (Figure  

3-6).  

 

�  Repeat 
�  Activate this function by click on the Repeat’s checkbox. 

�  Repeat Delay – the pause time between jobs; Unit: second. 

�  Repeat Counts – the number of repeat jobs.  

 

 

 

Figure 3-5 Figure 3-6 



                                                                    Expert 52 LX user manual 
 

Operation 3-8 

3.4 Data Transmission 
There are two options to transmit the data from the computer to the cutting plotter:   

Option 1: With proper interface settings, the data can be transmitted from your application 

software package to the cutting plotters directly. 

 

Option 2: Most cutting software packages are able to emulate HPGL or HPGL/2 commands, 

therefore. As long as the file is HPGL or HPGL/2 format, the cutting plotter can 

output the data precisely. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                    Expert 52 LX user manual 
 

Operation 3-9 

3.5 Expert 52 LX Print Driver setting 
3.5.1 Expert 52 LX Print Driver setting>Option Page 

 

File Function: 

The file function section allows users to set the parameters of Speed, Force, Offset and Quality 

for later use. This section is useful when performing repeated jobs on a variety of objects, 

allowing you to save your frequently used cutter parameters and load them in the future. 

 

• Custom Media: This section lists the files for the parameter settings that you have recently 

created and worked. You can save more than 50 files to simplify your cutting job. 

 

• Default: This section contains the reference settings that are applicable with the verified 

materials to achieve the best cutting results. Please note that the setting value might need to 

be adjusted according to different suppliers of materials. 

 

• SAVE: This function will save current print driver parameter settings to a file under the 

specified location on your computer. (Saved parameter setting files will be tagged with the 

Expert 52 LX series extension)  

 

• LOAD: This function allows you to load previously saved print driver parameters. 

 

• ORIGINAL: This function will load the print driver’s original factory parameter settings. 

 

• SAVE TO DEFAULT: This function allows you to save your current print driver parameters as 

the default startup settings. 

 

• DELETE: This function will delete the file you select from the Custom Media section, whereas 

the settings in Default section cannot be deleted. Please note the delete function only 

removes the list shown in Custom Media section, it does not remove the file from your hard 

drive, if you wish to completely remove the file from your hard disk, you will have to manually 

delete the file from your operating system. 

 

Die Cut 

The Die Cut function must be activated with the Kiss Cut function to avoid the falling of 

cut-through materials and material jam beneath the carriage. Die Cut helps you to cut through 

the backing of the material while Kiss Cut cuts through only the top layer but not the backing. 

This will leave only tiny bits of the backing attached to the top layer, creating complete individual 

patterns with backing sheets (see figure 3-7 and 3-8).  
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Figure 3-7 

 

 

Figure 3-8  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Cutting line 

Vinyl 
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To activate the Die Cut function, go to “Option”, tick “Die Cut”, and enter the amount you wish 

for the “Length” and “Force” of both Die Cut and Kiss Cut, then click “OK” (see figure 3-9).  

     

When the job is completed and you untick the Die Cut function, you will be able to adjust the 

pen speed, pen force, and offset in the section on the top following normal operating 

procedures (see figure 3-10). 

  

 

 

 

 

  

Note:  

1. The extension of the blade has to be set to 

cut through both the top layer and the backing 

in the very beginning. You then adjust the tool 

force for the best cutting performance.  

2. Once the Die Cut function is activated, it 

will perform on all the line segments on the 

object.  

  

Figure 3-10 

 

*Note:  

The length setting for the 

cutting line of Die Cut is in the 

range of 0-2000mm whereas 

that of Kiss Cut is 0-100mm. 

Figure 3.9 
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3.6 Reference Parameter setting for different mater ials  
 
The following reference parameter is used on GCC verified materials shown in the 
table.  
Material  Wall stickers Magnets Protective tint 

Blade red green green 

Blade tip length (mm) 0.3 0.8 0.3 

Force (g) 95 580 320 

Speed (cm/sec) 72 3 3 

Offset (mm) 0.275 0.5 0.5 

Recommend model RX, Jaguar RX, Jaguar 
RX, Jaguar, Puma, Bengal, Sable,  

Ex Pro, Ex 24/52, Ex 24/52 LX 

Material  Vehicle stickers Reflective film Cardboard 

Blade red green green 

Blade tip length (mm) 0.27 0.5 0.3 

Force (g) 85 380 165 

Speed (cm/sec) 60 3 30 

Offset (mm) 0.275 0.5 0.5 

Recommend model 

RX, Jaguar, Puma, 

Bengal, Sable, Ex Pro, 

Ex 24/52, Ex 24/52 LX 

RX, Jaguar, Puma, 

Bengal, Sable, Ex Pro, 

Ex 24/52, Ex 24/52 LX 

RX, Jaguar, Puma, Bengal, Sable,  

Ex Pro, Ex 24/52, Ex 24/52 LX 

Material  Window tint Window decoration 
Personalized 

stickers 
Rhinestone 

Blade red red red green 

Blade tip length (mm) 0.09 0.25 0.28 0.8 

Force (g) 70 95 105 190 

Speed (cm/sec) 72 65 72 15 

Offset (mm) 0.275 0.275 0.275 0.5 

Recommend model RX, Jaguar  RX, Jaguar  RX, Jaguar 
RX, Jaguar IV, 

Puma III 
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This chapter explains the basic maintenance (i.e. c leaning the cutting plotter) required 

for the cutting plotter. Except 52 LX for the steps  mentioned below, all the other 

maintenances must be performed by a qualified servi ce technician. 

 

 

4.1 Cleaning the cutting plotter  
 

In order to keep the cutting plotter under good conditions and have the best performance, you need to 

clean the machine properly and regularly.  

 

Precaution in Cleaning 

 
 

 

 

 

 

 

Recommended Methods 

 

�  Gently wipe the cutting plotter surface with a lint-free cloth. If necessary, clean it with a 

water-rinsed or an alcohol-rinsed cloth. Wipe the cutting plotter to remove any residues on the 

cutting plotter. Finally absorb water with a soft, lint-free cloth. 

�  Wipe all the dust and dirt from the tool carriage rail. 

�  Use a vacuum cleaner to clean any accumulated dirt and media residue beneath the pinch roller 

housing. 

�  Clean the platen, paper sensors and the pinch rollers with a water-rinsed cloth or alcohol-rinsed 

cloth. Finally absorb water with a soft, lint-free cloth. 

�  Use the same method mentioned above to clean dust and dirt from the stand. 

   

4.2 Cleaning the Grid Drum  
 
�  Turn off the cutting plotter, and move the tool carriage away from the area needed to be cleaned. 

�  Raise the pinch rollers and move them away from the grid drum for cleaning. 

�  Use a bristle (a toothbrush is also acceptable) to remove dust from the drum surface. It needs to 

rotate the drum manually to clean the drum completely (Figure 4-1). 

 

4. Basic Maintenance                                 

�  Unplug the cutting plotter before cleaning.  

�  Never use solvents, abrasive cleaners or strong detergents  for 

cleaning. They may damage the surface of the cuttin g plotter and 

the moving parts.   
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4.3 Cleaning the Pinch Rollers  
 

If the pinch rollers need a thorough cleaning, use a lint-free cloth or cotton swab to wipe away the 

accumulated dust from the rubber portion of the pinch rollers. To prevent the pinch rollers from rotating 

while cleaning, use your fingers to hold the pinch rollers in place. 

 

Use a lint-free cloth or cotton swab rinsed with alcohol to remove the embedded or persistent dust. 

Figure 4-1  
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Chapter 5 Automatic-Aligning System  

 

Please note that this chapter is only an instruction to AASII; for step-by-step instructions, please 

refer to the following chapters: 07_A-3 CorelDraw Plug-In, 07_A-4 GreatCut, 07_A-5 Illustrator. 

 
 
5.1 Introduction 
 

The Expert 52 LX cutting plotters feature a standard Automatic-Aligning System (AAS II) to 

guarantee precise contour cutting quality by detecting the registration marks printed around the 

graphic. 

 

Notice   

�  Avoid any kind of light source horizontally illuminating the AAS module.  

                                                                                                                                                                                    

                          

                                       
                        - PROHIBITED                        - ACCEPTABLE 

 

 

�  DO NOT take off the cover of AAS module while in operation.  

    
                       - PROHIBITED 
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5.2 AAS Calibrating the System 
 

The AAS system has one calibration procedures to ensure maximum accuracy of AAS 

operation. To operate the AAS you need to learn about the method of media feeding firstly. 

(Refer to 2.4 Media Loading.) 

 

5.2.1 Media Calibration  

Media Calibration is to ensure the sensor being able to recognize the registration marks. 

The factory default works on a wide range of materials. However, certain types of 

materials may not work properly. Performing a media calibration may become necessary 

while working with such materials to change the sensitivity of AAS for greater reliability.  

Media calibration adjusts the media feeding according to media type for better accuracy 

during cutting.  

 

�  When to use 

We suggest white media for best cutting result. It is not necessary to perform media 

calibration every time unless the registration marks on the printed media become 

undetectable in AAS sensing process. 

 

5.2.2 AAS Calibration  

The first registration mark is designed to be different in order to identify the origin for AAS 

auto-detection. The following precaution must be aware for registration marks to be read 

automatically. 

�  Type of media 

�  Registration mark pattern 

�  Reading range required for detection the registration marks 

�  Position for registration marks and medium 

          The registration marks have to be: 

�  Created by cutting software like GreatCut or GCC CorelDRAW plug-in 

�  In black color (printing quality of registration marks is essential; incorrect, 

misaligned colors, blurry or smeared printout might leading to inaccurate cutting 

result) 

�  Length: The length of marks 

�  Range: 5mm~50mm 

�  Optimized Setting: 25mm 

�  Thickness: The line thickness of marks 

�  Range: 1mm~2mm 

    �  Optimized Setting: 1mm 
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�  Margin: The distance between marks and images 

�  Range: 0mm~50mm 

�  Optimized Setting: 5mm 

The cutter can not detect the marks while: 

�  Cutter carriage is not located near the outside area of first mark before 

detecting (See the picture in page 5-7 for auto-detecting area of first mark.) 

�  Medium thickness is more than 0.8mm 

�  Transparent medium is used 

�  Non-monochrome drawing. The marks can’t be read if is printed on colored 

medium 

�  Dirty or creased medium surface 

 

5.2.3 AAS II on Expert 52 LX  

There are three types of AAS II mark patterns: 4-Point Positioning, Segmental Positioning, and 

Multiple Copies. Note that before print out your designs by inkjet printers, the registration marks 

have to be created on your graphic designs by cutting software like SignPal, GreatCut or GCC 

CorelDraw plug-in. Hand-made marks or drawings won’t be reorganized by  GCC cutting 

plotters.  For more details about registration mark setting in cutting software, please refer to 

‘Appendix A-3  : CorelDraw Plug-In Instruction’ and ‘Appendix A-4  : GreatCut Instruction’. 

 

1. 4-Point Positioning 

This is the basic mark pattern that AAS II will auto detect four registration marks and contour 

cut images inside those marks. 

�  Command: Esc.D1;(XDist);(YDist): 

�  Layout: 4 L-shaped marks at the 4 corners around the design 

 

2. Segmental Positioning 

In addition to 4 original points, the intermediate registration marks are added on both X axis 

and Y axis to help contour cut accurately, especially for cutting large images. 

�  Command: Esc.D2;(XDist);(YDist);(XStep);(YStep): 

�  Layout:  

In-between distance on X: 200~600mm, default 300mm 

In-between distance on Y: 200-600mm, default 300mm            
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3. Multiple Copies 

The function is used to duplicate images to let you cut quantities of images at a time.The 

AAS II sensor will automatically scan registration marks for each individual image to ensure 

the contour cutting precision.  

�  Command: Esc.D3;(XCopies);(YCopies);(Space): 

�  Layout:  

                             

          
 

5.3 Printer Test 
 

Before performing AAS contour cutting, it’s recommended to print out a test file that you 

can find in the enclosed Installation CD to make sure the AAS II cutting accuracy of 

Expert 52 LX. 

  

There are two testing files for AASII: 

1.    AAS II_X_Y_Offset_Caberation_A4 .eps (A4 size) 

2.    AAS II_X_Y_Offset_Caberation_600_600 .eps (Default setting, it is recommended 

for testing) 

�  Print out the testing graphic. ( Please use high precision printer) 

�  Load the graphic to Expert 52 LX and sent the file to test the cutting job 
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�  If there are any adjustments to be made, you can change the offset value by 

following the steps: 

�  Measure the offset values from the printed line and the actual cutting line. 

�  Enter the AAS Offset under MISC function for the values you just measured, 

then press Enter 

�  Test the cutting again 

�   AAS II offset X and Y value is defined as following:       

Horizontal line is defined as X and vertical is defined as Y (when facing the 

cutting plotter) 

�   When the actual cutting line and the printed line need to be changed towards 

the direction of origin mark, then simply add the negative value of the offset. 

If the direction is from the opposite of the origin mark, then enter positive 

values for the offset (see the following figures). This method applies to both 

X and Y axes. 
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Note:  

�  Before adjusting the AAS II settings, please proceed scaling for width and length. 

�  The blade offset value isn’t set for this test graphic, please set it according to the 

blade you use. 

�  If you have any question, please contact us or your local distributor for assistance. 

 

 

5.4 Registration Mark Offset Range  
Please correctly load your media (refer to the alignment ruler on the platen) to make sure the 

registration marks are successfully detected. Deviation exceeds the range below will lead to 

detection failure. 

 

 
 

 

 

5.5 Contour Cutting 
 

For accurate contour cutting with AAS function, please proceed the following steps: 

 

Step 1 Creating Graphics 

  �  Create the graphic that you want to print and cut in your software. 

 

 

 

  �  Create a contour for cutting around the graphic. 

 

 

 

TIPS1: Leave some space between the graphic and contour line. 

TIPS2: Create the contour in a separate layer and assign a different color for it. 
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        �  Add registration marks around the graphic. 

 

    Note: 

The Multiple Copies function is also available. It automatically copy the graphic and 

registration marks. 

 

Step 2 Placing the Registration Marks 

�  The AAS Layout Instruction: 

 

* The Auto Detection function will succeed as long as the carriage is positioned within the grey area.  

 

�  It is recommended to leave a 30mm left/right margin, 20mm margin on the top of 

the media sheet, and a bottom margin of at least 50mm to avoid sheets from 

dropping off or other errors that may occur during media sizing.    

�  Please note that the position of the 1st AAS registration mark should not be 

located within the area indicated by the yellowish part of the sticker on the main beam 

in Expert 52 LX cutting plotter. If the registration mark is located in the yellowish part 

of the sticker then the registration mark will fail to be detected.  
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Step 3 Print the Graphics  

  �  Print the graphic and the marks with your printer  

(Scaling = 100%).   

  �  When printing on a roll media, make sure the orientation as following: 

 

Step 4 Load the printout onto cutter 

  �  The Origin Mark is different from the rest registration marks. Please make sure the 

media is fed with correct direction. 

              
Step 5 Cut the Contour 

  �  Send out the command from software to perform the contour cutting job. 

 

 

5.6  Tips for AAS 
 

For getting better results of contour cutting, there are some tips below for your reference. 

�  Keep light sources simple and avoid illuminating from the sides of cutter. 

�  Before operating AAS, change the maximum paper size in Expert 52 LX driver 

property. 

STEP 1 Find the Expert 52 LX model in the “Printer & Fax” folder of your PC. 

STEP 2 Open the Properties window and select the “Paper” tab. 

STEP 3 Change the maximum Paper Size of X to 1200mm. 

�  Adjust the cutting speed to between 200~400mm/sec. 

�  Avoid the registration marks locating on the tracks of pinch rollers. 

�  Make sure the edge of the media is not bent up when detecting registration marks. 
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This chapter helps you to correct some common problems you may come across. Prior to 

getting into the details of this chapter, please be sure that your application environment is 

compatible with the cutting plotter.  

 

Note: 

Before contacting your local dealer, please make sure that the problems are coming from your 

cutting plotter, not from the communication between the computer and cutting plotter or from a 

malfunction in your computer or software. 

 

 
 
 
 
 
 
6.1 What if Expert 52 LX cannot operate?  
 
If your cutting plotter doesn’t plot, please check the following items first: 

 

Solutions: If the POWER LED lights on, the cutting plotter should be in a normal condition.  

         Turn off the cutting plotter and turn it on again to see if the problem still exists. 
    If the POWER LED doesn’t light, please call your local dealer to resolve this problem. 
 
 

6.2 Light Indicators    
 
Some of the operating problems can be identified by the lights on the control panel.  

When your cutting plotter stops operating or the lights are on or flashing unexpectedly, see the 

following descriptions of the panel light patterns and the actions you should take. 

 

 

 

 

 Is the power cord plugged in properly? 

 Is the power cord connected to the power connector properly? 

 Is the power switch turned on properly?  

6. Trouble Shooting                   

Why doesn’t the cutting plotter operate? 



                                                                  Expert 52 LX user manual 
 

Trouble Shooting                                      6-2 

6.2.1 Warning Indicators 

 

When the ERROR LED flashes (as shown below), take the necessary actions according to 

the following instructions. When the problems are solved, the ERROR LED will turn off 

automatically. Pressing the ON/OFF LINE button can also turn off the ERROR LED. 

 

Warning Indicators ERROR 
ON/OFF 

LINE 
REPEAT 

DATA 

CLEAR 

CUT 

TEST 

1 Graph was clipped      
2 HPGL/2 command Error      
3 Lever up or no media      
4 Cannot repeat      
5 Communication error      
6 Width sensor error      
7 Check media, drum or X motor      

 = flash        = on         = off 

 

Warning 1  The graph is clipped   

This condition indicates that the cutting graph is bigger than the cutting area.  

 

You can solve the problem by:  

1. Reload a wider or longer media.  

2. Move the pinch rollers to widen the cutting area.  

3. Re-scale the graph to a smaller size. Then send the cutting job again from your computer 

to the cutting plotter. 

 

 

Warning  2 HPGL/2 command error   

If the cutting plotter cannot recognize the commands from your computer, please check the 

commands applied to your cutting plotter in the HP-GL/2 or HPGL commands. Then send the 

same job to the cutting plotter again. 

 

If that doesn’t solve the problem, please contact your local dealer. 

 

Warning 3 Lever up or no media    

Check that you have lowered the lever down and make sure that you load the media before 

cutting. 
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Warning 4  Cannot repeat cutting 

There are two possibilities:  

1. There is no data in the buffer: please send the job again from your computer;  

2. The buffer is full: please send the same job from your computer again.  

Under both conditions, press the ON/OFF LINE key to clear the warning message. 

 

Warning 5  Communication error 

Check that the serial/USB cable has been connected to the cutting plotter and computer 

properly.  

 

If so, then check whether the interface settings are correct. Check that the communication 

settings in your PC are the same as the ones on your cutting plotter (for example – 9600bps, 

no parity, 8 bits, 1 stop bit). Then, press ON/OFF Line key to switch back to On Line mode.  

 

Warning 6  Width sensor error 

Check that the pinch rollers are positioned above the grid drum and reload the media again.  

 

6.2.2 Error Indicators 

 

If some mechanical problems occur during the operation, the ERROR LED will turn on. Please 

follow the instructions below to solve the problem. If the cutting plotter still cannot work, 

please contact your local dealer and tell him or her about the error indicator. 

 

 Error Indicators ERROR 
ON/OFF 

LINE 
REPEAT 

DATA 

CLEAR 

CUT 

TEST 

1 SRAM error      
2 DRAM error      
3 Check media, drum, or X motor      
4 Check media or Y motor      

 = flash        = on         = off 

Error 1 and 2 

Please contact your local dealer to replace SRAM or DRAM. 

 

Note:  

In order to identify the warning messages easily, please stick the warning 

sticker (in accessory box) on the side cover of your cutting plotter. 
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Error 3 Check the media, drum or X-motor (Drum driven motor)     

This message indicates that there might be a problem on the X-axis .  

Please check that the drums are working normally and see that the media is well loaded. Then turn on 

the power and reboot the cutting plotter. 

 

Error 4 Check the media, or Y motor (carriage driven motor) 

This message indicates that there might be an obstruction to the carriage relating to a problem on the 

Y-axis .  

Please clear the obstruction and check that the carriage can move smoothly. Then turn on the power 

and reboot the cutting plotter. 
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6.3 Cutting Quality Problems  
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Is the blade installed correctly and the blade 

holder fastened securely? 

Yes No 

Is the blade dull 

or chipped? 

Yes No 

Replace 

with a new 

blade 

Is tool force set up 

properly? (The default 

for tool force is 80 gf) 

Yes No 

Adjust the tool force to obtain an 

optimum blade force. Refer to 

Chapter 4.3 “Cutting Force and 

Offset Adjustment” 

Is the tool offset set up 

properly? 

Yes No 

Adjust the tool offset to 

obtain an optimum value. 

Is there any dirt adhered to 

the blade? 

Yes No 

Refer to Chapter 2.3 

“ Blade Installation” 

Remove the 

blade and clean 

it. 

Please contact your dealer for 

technician support.  

Note: The daily maintenance of your cutting plotter is very important. 

Be sure to clean up the grid drum and pinch rollers regularly for better 

cutting accuracy and output quality.��
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 Model EX-52 LX 
 Max. Cutting Width 1320mm(51.96in) 
 Max. Media Width 1470mm(57.87in) 
 Material Thickness 0.8mm 
 Max. Cutting Force 250g 
 Max. Cutting Speed(Diagonal) 400 mm /sec (15.7"/sec) 

Mechanical Resolution �������������P�P�� ��

 Software Resolution 0.025 mm 
Distance Accuracy ±0.254 mm or ±0.1% of move, whichever is greater 

 Repeatability ±0.1mm 
 Re-plot Memory 500 Kbyte 
 Interfaces USB 2.0 (Full Speed) & RS-232           
 Commands HPGL, HPGL/2 
 Configurable Origin Yes 
 Control Panel 6 LEDs/10 Keys 
 Stand Standard 

Automatic-Aligning System 
Completely Automatic Contour Cutting System for 

print to cut solution 
 Temperature 15°C~30°C / 60°F~86°F Operation      

Environment  Humidity 25% ~ 75% 

�  Compatible with Windows 2000/ XP/ Vista/ 7/ 8 and MAC OS X 10.4-10.7. 

�  The specification and data sheet may vary with different materials used. In order to 

obtain the best output quality, please maintain the machine regularly and properly. 

�  GCC reserves the right to change the specifications at any time without notice 

�  The above listed specification values are effective only when operated with media 

certified by GCC. 

 

 

 
 

Expert 52 LX Specification 
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For cutting thick fluorescent and reflective vinyl. Also for cutting 
detailed work in standard vinyl. 

20200159G 

The blade is 45° with Red Cap(5-unit package), 0.25 mm offset 

 

For cutting reflective vinyl, cardboard, sandblast, flock, and 
stencil sharp edge. 

265012020G 

The blade is 60° with Green Cap , 0.50 mm blade offset 

 

For cutting thin sandblast mask and stencil with friction feed or 
sprocket feed machine. 

26500059G 

The blade is 60° with Blue Cap , 0.25 mm blade offset 

 

For Cutting small text and fine detail. Sharp blade with smallest 
offset. 

26500060G 

The blade is 0.175 mm blade offset with Black Cap  

 

265012840G For thin and delicate media such as window tint. 

 The blade is 25° with Yellow Cap , 0.25 mm blade offset 

 

���������	
�
	��

�  
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About the Tool 
 

A generic term referring to the blade that cuts the sheet, the pen that does plotting, and the 

LED bombsight (option) used for pointing to the reference point. 

OFFSET is the distance that the blade tip is displaced from the centerline of the blade. 
 

 
 

 

 

 

                                        

 

 

                   

                                                                  

 

                                                                  

 
 

Protrusion Length of the Blade 
 

 

 

 

 

 

 

 

 

 

 

 

Length of protrusion = t1 + t 2/ 2, but for your convenience you may just make it about 

0.3mm ~ 0.5mm beyond the blade holder tip. 

 

 Central line   

Blade  

  Blade tip 

offset  

Thickness of the 

base paper (t 2) 

Thickness of  

the media (t1)  

Protrusion length 

of the blade  
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AASII VBA Installer is applicable for CorelDRAW Version 13, 14, 15, 16 

 

Installation  
 

1. Check the “AAS CorelDraw Installer” folder in Ex 52 Lx Installation CD, and double click 

the “AASIIVBAInstaller.exe” file to run the installation program.  

 

 

2. Press the “Install” button to begin installing GCC AASII CorelDRAW VBA. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

��������	
���
���
�����������
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User Instructions  
 

1. Run CorelDRAW to edit your graphics and select all images at once when you wish to 

plot.  

 

 

2. Select “Tools� Visual Basic� Play”.    
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The Visual Basic for Applications Marcos window will pop up.  

Select Global Macros(GCCAASII_Draw13.gms) under the “Macros in” manual, and press 

“Run”.  

 

 

3. Click on “Apply” and select whether you would like to add the registration marks by page 

size or by object. 

 

 

 

 

 

 

 

 

 

 

 

Note: “Add Registration Mark by Object” will be the default 

selection if you click on the image whereas “Add 

Registration Mark by page size” will be the default one 

when the blank area on the page is clicked. 

 

 

4. Now you can print out the image file with registration marks. 
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Add Registration Mark by page size  
 

If you tick “Add Registration Mark by page size” as shown in the figure below and click “Apply”, 

your registration marks will be created automatically. 

 

Note:  

1. The length setting will be in the range of 5-25mm 

according to your page size. 

 

2. Please DO NOT make any changes to the “Origin” 

section when you choose to add registration marks by 

page size as indicated below otherwise the position of 

the marks will be changed.  

 

 

 

 

 

 

 

 

 

 

 

 

The system will create the 4 marks on the 4 corners of the page as shown in the picture below 

wherever you move your image. 
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Workable area 

It allows users to extend the registration mark when editing graphics. 

 

For A4 size media sheet, the workable area is 2.5mm extended from the registration mark on 

left and right sides and 4.5mm extended from the registration mark on top side. On the bottom 

side, it is suggested to leave at least 25mm margin from the edge of media sheet to prevent 

sheets dropping or any error occurred while media sizing. 

 

For A3 size media sheet, the workable area is 10mm extended from the registration mark on the 

left side, 9mm extended from the registration mark on the right side and 11mm extended from 

the registration mark on top side. On the bottom side, it is suggested to leave at least 25mm 

margin from the edge of media sheet to prevent sheets dropping or any error occurred while 

media sizing. 

 

 
 

NOTE: Select “Edge” mode when media sizing to allow the media sheet to be unrolled. If you 

select “Single ” mode, the media sheet will not be able to be moved back and hence fail to be 

detected by front paper sensor. 
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Add Registration Mark by Object  
 

If you tick “Add Registration Mark by Object”, you will be offered three options of registration 

marks as shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

Note: The values entered in the “4-Point Positioning” section (length, thickness and margin) will 

still be applied when you tick “Segmental Positioning” or “Multiple Copies”. 

 

 

 

 

 

 

4-Point Positioning 

�  Length: The length of marks 

�  Range: 5mm~50mm 

�  Optimized Setting: 25mm 

�  Thickness: The line thickness of marks 

�  Range: 1mm~2mm 

�  Optimized Setting: 1mm 

�  Margin: The distance between marks and images 

�  Range: 0mm~50mm 

�  Optimized Setting: 5mm 

 

Segmental Positioning 

�  X Step: The distance of intermediate position on the X axis 

�  Y Step: The distance of intermediate position on the Y axis 

�  Range: 200mm~600mm 

�  Optimized Setting: Less than 500mm 

 

Multiple Copies 

�  No. of X Copies: The numbers of copies on X axis 

�  No. of Y Copies: The numbers of copies on Y axis 

�  Range: 1~50. (The more copies you make, the more time 

is needed for data transmission.) 

�  Numbers of X Copies * Numbers of Y Copies = The total 

amount of image copies 

�  Copies with outline�ÖTo show outlines of image graphics 
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4-Point Positioning 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The system will create the 4 marks as shown in the picture below. 

 
 

4-Point Positioning 

�  Length: The length of marks 

�  Range: 5mm~50mm 

�  Optimized Setting: 25mm 

�  Thickness: The line thickness of marks 

�  Range: 1mm~2mm 

�  Optimized Setting: 1mm 

�  Margin: The distance between marks and images 

�  Range: 0mm~50mm 

�  Optimized Setting: 5mm 
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Note:  

To save your materials, in addition to amending object margins, you can also adjust the 

length of the registration marks (5mm minimum) when you apply 4-Point Positioning (see 

table 1 for suggestions based on different material sizes). The smaller the size is, the smaller 

the distance between the object and the registration marks is (see the figures below). 

 

 

 

 

 

 

 

 

 

 

 

 

 

Page size 

(unit: mm) 

Suggested mark length 

(unit: mm) 

A6 (105 x 148) 5 

A5 (148 × 210) 8 

A4 (210 × 297) 11 

A3 (297 × 420) 16 

A2 (420 × 594) 23 

A1 (594 × 841) and above 25�½ 

 

Table 1 
�½25mm is the suggested value for the registration mark length 

 

2. The size of the registration marks would affect the accuracy of registration mark detection 

so please make sure the amount you enter is reasonable.         

 

3. If you change the paper size, you will have to reset the registration marks otherwise the 

previous setting will be applied. 

 

 

 

Area to be cut 
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Segmental Positioning 

For precise cutting quality, it is suggested to select “Segmental 

Positioning” when you are working on an extra long or large-sized 

image to increase cutting accuracy. 

 

 

 
Segmental Positioning 

�  X Step: The distance of intermediate position on the X axis 

�  Y Step: The distance of intermediate position on the Y axis 

�  Range: 200mm~600mm 

�  Optimized Setting: Less than 500mm 

 

 

 

 

 

The system will create the as shown in the picture below 

 

Segmental Positioning 
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Multiple Copies 

It is suggested to select “Multiple Copies” when you would like to make several copies of one 

image on your material to increase cutting accuracy.  

 

 

 

 

 

Multiple Copies 

�  No. of X Copies: The numbers of copies on X axis 

�  No. of Y Copies: The numbers of copies on Y axis 

�  Range: 1~50. (The more copies you make, the more time is needed 

for data transmission.) 

�  Numbers of X Copies * Numbers of Y Copies = The total amount of 

image copies 

�  Copies with outline�š To show outlines of image graphics 

 

 

 

The system will create the as shown in the picture below. 

 

 

X axis 

Y axis 
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Segmental Positioning will be applied to Multiple Copies when the object to be copied is of large 

size (with the length or width over 200mm) to increase the accuracy of registration mark 

detection. 

 

 

 

 

 

Segmental Positioning 

Please make sure you are happy with 

the settings for Segmental Positioning 

as these will be applied to the copies 

created. 
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Contour cutting through CorelDraw  

Step 1: Position the paper with registration marks printed by your printer on the GCC cutter. 

Step 2: Select “Files� Print”. 

 

Please note that if you use CorelDraw X5, you must follow the steps below. 

Click the “color” page and go to the “Color conversions performed by:” and then select the 

model name of you cutter.   
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Step 2: Go to the “Layout” page and select Bottom left corner at “Reposition images to”. 

 
 

Step 3: Click “Print”. 

 

You can also add a Hot Icon for the AAS II Plug-in  
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Step 1: Select “Tools� Customization� Commands� Macros”. 

 

 

 
Step 2: Choose�¼GCC_CorelDraw_AASII.GCCModule.GCC_AASII�½and drag it to the 

“commands” bar.  

 

Step 3: If you want to have a different icon, select “Tools� Customization� Commands�  

Appearance” to import a graphics for use as the icon. Choose an icon and press OK to 

complete this setting. 
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The user manual of GreatCut 2 software is available on the GCC installation CD. 

 

GCC AASII System 

Below is a step-by-step instruction of using the AAS function of GreatCut 2 software through 

CorelDRAW and Adobe Illustrator.  

 

 

Edit your image in CorelDRAW  
 

 

 

4-Point Positioning  

Step 1. Create a new file in CorelDRAW and click on the Create contour icon in the GreatCut 2 

toolbar (it would appear automatically once CorelDRAW is open). 

 
 

 

 

���������	
������
�
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Step 2. Complete contour line settings (including contour offset value) and press Calculate to 

confirm. 

 
Contour lines will be added to the images. 

 
 

 

Contour offset is the 

distance between the object 

and the contour line. 
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Step 3. Press the Settings icon on the GreatCut 2 toolbar.  

 
 

Step 4. Press the button on the right of Jog marks. 
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Step 5. Adjust the size, object margin and line thickness of your registration marks in the Setup-Jog 

Marks window and click OK. 

 

 

Step 6. Ensure the three items below are selected and click OK. 

  
 

 

 

 

 

 

 

4-Point Positioning 

�  Size: The length of marks 

�  Range: 5mm~50mm�³

�  Optimized Setting: 25mm 

�           Object margin: The distance  

between marks and images 

�  Range: 0mm~50mm 

�  Optimized Setting: 5mm 

�   Line thickness: the line thickness 

of marks 

�  Range: 1mm~2mm 

�  Optimized Setting: 1mm 
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Step 7. Click the Set Jog Marks Icon in the GreatCut 2 toolbar. 

 
The system will create the 4 marks as shown in the picture below. 
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Note:  

1. To save your materials, in addition to amending object margins, you can also adjust the length of 

the registration marks (5mm minimum) when you apply the above function(see table 1 for 

suggestions based on different material sizes). The smaller the size is, the smaller the distance 

between the object and the registration marks is (see the figures below).  

                  
 

 

 

 

 

 

 

 

 

Table 1 

*25mm is the suggested value for the registration mark length 

 

2. The size of the registration marks would affect the accuracy of registration mark detection so 

please make sure the amount you enter is reasonable.         

 

 

 

 

 

 

 

 

Page size 

(unit: mm) 

Suggested mark length 

(unit: mm) 

A6 (105 x 148) 5 

A5 (148 × 210) 8 

A4 (210 × 297) 11 

A3 (297 × 420) 16 

A2 (420 × 594) 23 

A1 (594 × 841) and above 25* 

Area to be cut 
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Output  

Step 1. Select both the entire object (including registration marks and the contour line) and press the 

Cut icon in the GreatCut 2 toolbar. 

 

Step 2. The system will activate GreatCut2 automatically and import the registration marks and 

contour line to GreatCut 2. 
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Step 3. Select Output under File. 

 

Step 4. Select Cut with AAS in Mode/Tool in the Output to device window. 

 

 

Complete the settings of AAS 

Offset, Pressure, Speed, 

Material width and so forth. 
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Step 5. Click output and the object will be sent to GCC Cutting Plotter 
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Advanced Settings  
 

Segmental Positioning 

For precise cutting quality, it is suggested to apply “Segmental Positioning” by adjusting the x and y 

distance when you are working on an extra long or large-size image to increase cutting quality. 

 

Follow the same steps in the 4-Point Positioning section to complete the contour line setting and 

registration mark creation procedures. Adjust the size, object margin and line thickness of your 

registration marks and the space between registration marks by changing X, Y distance in the 

Setup-Jog Marks window and click OK. 

  

The system will create the marks as shown in the picture below. 

Segmental Positioning 

�  Max. x Distance: The distance of 

intermediate position on the X axis 

    �  Range: 200-500 mm 

�  Max. y Distance: The distance of 

intermediate position on the Y axis 

    �  Range: 200-500 mm 
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Follow the same steps in the Output section to output your image to GCC Cutting Plotter. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Segmental Positioning 

X axis  

Y axis  
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Multiple Copies 

 

Follow the same steps in the 4-Point Positioning section to complete the contour line setting and 

registration mark creation procedures.  

 
Click the Set Jog Marks Icon in the GreatCut 2 toolbar and 4 marks will be created as shown in the 

picture below. 

 

When you apply the “Multiple 

Copies” function, the value that 

has been set in this section will 

still be applied. 
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Click the Multi-copy Icon in the GreatCut 2 toolbar and complete the Number in X/Y (the number of 

copies desired on the X/Y axis) and Distance in X/Y (distance between each copy) settings then click 

OK. 

 

 
Note: The spacing of vertical & horizontal (Offset X & Y) should be �  20mm or = 0mm; Users are 

advised to set the Distance in X/Y as 0 mm to remove the space between each copy to avoid the 

waste of materials. 
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The system will create several copies of the object with registration marks as shown in the picture 

below. 

 

 

Follow the same steps in the Output section to output your image to GCC Cutting Plotter. 
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Edit your image in Adobe Illustrator  
 

 

4-Point Positioning  

 

Step 1. Create a new file in Adobe Illustrator.  

 
Step 2. Select the image and go to Contour in GreatCu2 in File. 
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Step 3. Complete contour line settings (including contour offset value) and press Calculate to 

confirm. 

 
Contour line is now added to the object. 

 
 

 

 

 

 

Contour offset is the distance 

between the object and the 

contour line. 
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Step 4. Click Settings in GreatCut 2 under File. 

 

Step 5. Press the button on the right of Jog marks. 
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Step 6. Adjust the size, object margin and line thickness of your registration marks and click OK. 

 

 

 

Step 7. Ensure the three items below are selected and click OK. 

  
 

 

 

 

 

 

 

4-Point Positioning 

�  Size: The length of marks 

�  Range: 5mm~50mm�³

�  Optimized Setting: 25mm 

�           Object margin: The distance  

between marks and images 

�  Range: 0mm~50mm 

�  Optimized Setting: 5mm 

�   Line thickness: the line thickness 

of marks 

�  Range: 1mm~2mm 

�  Optimized Setting: 1mm 
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Step 8. Click Set Jog Marks in GreatCut2 under File. 

 

The system will create the 4 marks as shown in the picture below. 
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Output  

Step 1. Select both the entire object (including registration marks and the contour line) then click Cut 

in GreatCut2 under File. 

 
Step 2. The system will activate GreatCut2 automatically and import the registration marks and 

contour line to GreatCut 2. 
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Step 3. Select Output under File. 

 
Step 4. Select Cut with AAS in Mode/Tool in the Output to device window. 

 

 

Contour offset is the 

distance between the object 

and the contour line. 
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Step 5. Click output and the object will be sent to GCC Cutting Plotter 
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Advanced Settings  
 

Segmental Positioning 

For precise cutting quality, it is suggested to apply “Segmental Positioning” by adjusting the x and y 

distance when you are working on an extra long or large-size image to increase cutting quality. 

 

Follow the same steps in the 4-Point Positioning section to complete the contour line setting and 

registration mark creation procedures. Adjust the size, object margin and line thickness of your 

registration marks and the space between registration marks by changing X, Y distance in the 

Setup-Jog Marks window and click OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Segmental Positioning 

�  Max. x Distance: The distance of 

intermediate position on the X axis 

    �  Range: 200-500 mm 

�  Max. y Distance: The distance of 

intermediate position on the Y axis 

    �  Range: 200-500 mm 
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Click the Set Jog Marks Icon in the GreatCut 2 toolbar and 4 marks will be created as shown in the 

picture below. 

 

 
 

Follow the same steps in the Output section to output your image to GCC Cutting Plotter. 
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Multiple Copies 

 

Follow the same steps in the 4-Point Positioning section to complete the contour line setting and 

registration mark creation procedures.  

 
Click the Set Jog Marks Icon in the GreatCut 2 toolbar and the system will create the 4 marks as 

shown in the picture below. 

 

When you apply the “Multiple 

Copies” function, the value that 

has been set in this section will 

still be applied. 
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Click Multi-Copy in GreatCut2 under File. 
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Complete the Number in X/Y (the number of copies desired on the X/Y axis) and Distance in X/Y 

(distance between each copy) settings then click OK. 

 
Note: The spacing of vertical & horizontal (Offset X & Y) should be �  20mm or = 0mm; users are 

advised to set the Distance in X/Y as 0 mm to remove the space between each copy to avoid the 

waste of materials. 

 

 

The system will create several copies of the object with registration marks as shown in the picture 

below. 

 

 

 

Follow the same steps in the Output section to output your image to GCC Cutting Plotter. 
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AASII VBA Installer is applicable for Illustrator Version CS4, CS5, CS6, CC. 

 

Installation  
 

1. Check the “AAS Illustrator Installer” folder in Installation CD, and double click the 

“AASIIInstaller.exe” file to run the installation program.  

 

 

2. Press the “Install” button to begin installing GCC AASII Illustrator VBA. 
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Printer Setting  
Step1: Right click on the printer and select Properties to open the Printer Properties page 

 

 

Step2: Go to the Advanced page and make sure the Enable advanced printing features box 

is unchecked. 
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User Instructions  
 
1) Open Illustrator. 

 

2) Edit your image and create a contour line (Note: you must have the line width set as 

0.001mm). 

 

3) Click on the image and apply the AAS function 

(File� Scripts� _AASII_Reg_Mark_Setting_01_03_02) 

 

Contour line 
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4) Select the registration marks needed 

 

 

5) Three types of registration marks are introduced here: 4-Point Positioning, Segmental 

Positioning and Multiple Copies. 

 

 

Note:  

The values entered in the “4-Point Positioning” section 

(length, thickness and margin) will still be applied when 

you tick “Segmental Positioning” or “Multiple Copies”. 
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6) Confirm the registration marks (the 4-Point Position mark is used as an illustration in the 

following steps). 

 
 

7) Click on the blank area on the page and then click “Document Setup”. 
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8) Hit “Edit Artboards”. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

9) Click on “Presets �  Fit Artboard to Artwork bounds”. 
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10) Please move your mouse to the tool bar on the left when step 10) is finished and then click 

“Selection Tool”. 

 
 

11) This will take you back to the edit mode. 
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12) Print out the file with the contour line and the registration marks. 

 
 

13) Place the printed file on the cutter, lower the pinch rollers and then position the carriage at 

the origin of the registration marks. 

 

14) Send the file to the cutter. 
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15) Select the cutter model, position the object in the bottom left corner.  

 
 

16) Your job is now completed. 
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Add Registration Mark by page size  
If you want to create registration mark by page size, go to “Scripts” under “File” and select 

“_AASII_Plug_In” 

 

 
Tick “Make by page size” and click “Apply” and the registration 

mark will be created on the 4 corners of the page automatically, 

sown as below. 

 

 
Note:  

The length setting will be in the range of 10-50mm according to your page size 
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Workable area 

It allows users to edit and cut graphics in the area outside the registration marks when adding 

registration marks by page. 

 

For A4 size media sheet, the workable area is 2.5mm extended from the registration mark on 

left and right sides and 4.5mm extended from the registration mark on top side. On the bottom 

side, it is suggested to leave at least 25mm margin from the edge of media sheet to prevent 

sheets dropping or any error occurred while media sizing. 

 

For A3 size media sheet, the workable area is 10mm extended from the registration mark on the 

left side, 9mm extended from the registration mark on the right side and 11mm extended from 

the registration mark on top side. On the bottom side, it is suggested to leave at least 25mm 

margin from the edge of media sheet to prevent sheets dropping or any error occurred while 

media sizing. 

 
NOTE: Select “Edge” mode when media sizing to allow the media sheet to be unrolled. If you 

select “Single ” mode, the media sheet will not be able to be moved back and hence fail to be 

detected by front paper sensor. 
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Add Registration Mark by Object  
 

If you add registration mark by Object, you will be offered three options of registration marks. 

 

Firstly, select the graphic which you want to add registration mark on and go to “Scripts” under 

“File” and select “_AASII_Plug_In”. 

 

 

Make sure to untick “Make by page size” and choose one of 

the registration mark types whichever is suitable.  
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Three types of registration marks 
 

4-Point Positioning 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The system will create the 4 marks as shown in the picture below. 

 

4-Point Positioning 

�  Length: The length of marks 

�  Range: 5mm~50mm 

�  Optimized Setting: 25mm 

�  Thickness: The line thickness of marks 

�  Range: 1mm~2mm 

�  Optimized Setting: 1mm 

�  Margin: The distance between marks and 

images 

�  Range: 0mm~50mm 

�  Optimized Setting: 5mm 
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Note:  

1. To save your materials, in addition to amending object margins, you can also adjust the 

length of the registration marks (5mm minimum) when you apply 4-Point Positioning (see 

table 1 for suggestions based on different material sizes). The smaller the size is, the 

smaller the distance between the object and the registration marks is (see the figures 

below).  

                  
 

 

 

 

 

 

 

 

 

Table 1 
�½25mm is the suggested value for the registration mark length 

 

2. The size of the registration marks would affect the accuracy of registration mark detection so 

please make sure the amount you enter is reasonable.         

 

 

 

 

 

 

 

Page size 

(unit: mm) 

Suggested mark length 

(unit: mm) 

A6 (105 x 148) 5 

A5 (148 × 210) 8 

A4 (210 × 297) 11 

A3 (297 × 420) 16 

A2 (420 × 594) 23 

A1 (594 × 841) and above 25�½ 

Area to be cut 
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Segmental Positioning 

For precise cutting quality, it is suggested to select 

“Segmental Positioning” when you are working on an 

extra long or large-sized image to increase cutting 

accuracy. 

 

 

 

Segmental Positioning 

�  X Step: The distance of intermediate position on the 

X axis 

�  Y Step: The distance of intermediate position on the 

Y axis 

�  Range: 200mm~600mm 

�  Optimized Setting: Less than 500mm 

 

 

 

 

 

 

The system will create the marks as shown in the picture below 

 

Segmental Positioning 
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Multiple Copies 

It is suggested to select “Multiple Copies” when you 

would like to make several copies of one image on your 

material to increase cutting accuracy.  

 

 

 

 

 

Multiple Copies 

�  No. of X Copies: The numbers of copies on X axis 

�  No. of Y Copies: The numbers of copies on Y axis 

�  Range: 1~50. (The more copies you make, the 

more time is needed for data transmission.) 

�  Numbers of X Copies * Numbers of Y Copies = 

The total amount of image copies 
�  Copies with outline�š To show outlines of image 

graphics 
�  Margin: Space between marks; must be 0 or �
  20, 

no negative numbers allowed 

 

The system will create the as shown in the picture below. 

 X axis 

Y axis 
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The new SignPal 10.5 Software is Windows System compatible and all versions support the AAS II contour cutting 

function of RX, Jaguar IV, Puma III, Expert 24 LX, and Expert 52 LX cutting plotters.  

 

SignPal 10.5 Instruction Index: 

[1] Installing the SignPal 10.5 software 

[2] Set up your GCC Cutter on Production Manager 

-- SignPal AAS II Quick Start 

[3] SignPal 10.5 Feature Lists 

 

 [1] Installing the SignPal 10.5 software  

To install the software, you must have Administrator privileges. To use the software, you must 

have Administrator or Power User privileges. See your Windows user guide for more 

information. 

1. Make sure the dongle is inserted. 

2. Uninstall any previous version of the software. 

3. Insert the Installation DVD. 

4. Select a language and click OK. 

5. Click Next . 

Please note that the pictures below of SignPal 10.5 serve as illustrations in the following steps. 
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6. Read the Software License Agreement and select I accept the terms of the license 

agreement  and click Next  to accept. 

 

 

7. If you did not have any previous versions of the software installed, skip to the next step. If 

you still have a previous version of the software installed, you will be prompted to overwrite 

the existing installation. Click Yes to overwrite any previous installation of the software. 

 

 

8. Select the features of the software that you want to install and click Next : 

·  Check GCC Production Suite  to install the software. 

·  Check Samples  to install sample files. 

·  Check SafeNet Sentinel System Driver  to install the software driver for this key. If you 

do not use this type of key, you do not need to install this driver. 
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A. To change the default destination folder, click Browse  and choose a new destination 

folder. 

B. To check that the drive you are installing to has enough space for the installation: 

a. Click Disk Space . 

b. From the drop-down menu, select the drive you want to install to, and verify that it 

has enough space for the installation. 

c. Click OK. The installation drive changes to the selected drive when you click OK. 

 

9. Select the Program folder where the shortcut for the software will appear. A new folder is 

automatically created for the product. 

 

10. Click Next  to install the software. 
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11. Once the installer is finished installing, the Install Manager  opens. The Install Manager will 

automatically enable you to access the software and any optional features. 

 

 

12. Click Done. 
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13. Check which icons and preferences you want to install: 

·  Check Install to desktop  to install a shortcut for the software on the desktop. 

·  Check Install to startup items  to install a shortcut for the software in the Startup folder 

of the Start menu. If this is done, each time the computer starts up, the software will 

automatically start up and minimize itself, displaying an icon in the system tray of the 

Windows system tray. 

·  Check Clear Application's previous preferences  to clear the preferences or clear the 

check box to retain old preferences. 

·  Click OK. 
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14. Open SignPal 10.5v1 

 

 

15. As you have not registered before, please check on the box at bottom to register a new 

account.  

 

 

16. Input your personal information to complete the online registration. 



                                                     Expert 52 LX User Manual 

SignPal 10.5 Instruction                           A-6  7 

 

 

17. If you have registered before, please enter your Registration code as below to open SignPal 

10.5v1 software. 
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Note:  

1. Steps 15-17 will only be compulsory for users who have never registered before. 

2. You will be prompted to the demo version registration process if the version of your dongle 

does not match that of the software. 

 

Do one of the following: 

 

·  Check Run in demo mode  to run a demo version of any available products in any 

available language. 

·  Ignore the password that's shown in the box, use the Add button to enter any additional 

passwords in the Optional Password section to unlock optional features. If you 

purchased additional options or you are using a different dongle than the one you 

inserted when the software was run, you may enter the option passwords in this field to 

upgrade or access your software. 

·  Click Done. 
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[2] Set up your GCC Cutter on Production Manager  

 

1. Open Production Manager 10.5v1  

2. Choose and set up your GCC cutter. 

(Note that AAS II System only works on RX, Jaguar IV, Puma III, Expert 24 LX, and Expert 52 

LX.) 
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3. Select File > Print Setup in SignPal Software. 

 

4. Select the printer and paper size. 
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-- SignPal AASII Quick Start 

 

5. Use the Rectangle Tool  to create a rectangle. 



                                                     Expert 52 LX User Manual 

SignPal 10.5 Instruction                           A-6  14 

 
 

6. Select Effect > Contour Cut . Then click ‘Apply’ in DesignCentral window. 
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7. Apply the contour cut mark of GCC AASII by selecting Effect > Contour Cut Mark .  

 
 

8. Select “GCC AASII ” in SignPal DesignCentral window to create the AAS II registration marks 

(4-Point Positioning). Set the vales as 0.1cm or above and click ‘Apply ’ in DesignCentral 

window. The value is to define the distance between registration marks and image area. If the 

value is less than 0.1cm, it is likely that the image will overlap the marks and result in bad 

cutting quality. 

 
 

9. There are three types of GCC AASII registration marks: 4-Point Positioning, Segmental 

Positioning, and Multiple Copies. To make ‘Segmental Positioning’ marks, please select “GCC 
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Segmentation ” in DesignCentral window and then click ‘Apply ’.  

 

 

10. For ‘Multiple Copies’, this function is not available in SignPal. Currently the ‘Multiple Copies’ 

function is only available under CorelDraw plug-in. 

 

11. Select File > Print  to print out the image. 
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12. Set the Scale as 100cm =1m (100%) in Print page. 

 

 

13. Load the printout vinyl on the plotter and select File > Cut Contour  to send data. You can 

preview the job and change cutter’s parameter settings in ‘Properties’ tab of Cut Contour 

window. The Production Manager will be automatic activated to complete the job. 
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[3] SignPal 10.5 Feature Lists  

 Pro Master Expert Apprentice  

     

Text     

Text tool �  �  �  �  

Arc Text �  �  �   

Path Text �  �  �   

Vertical Text �  �  �  �  

Vertical Path Text �  �  �   

Kerning �  �  �   

Break apart/ Join �  �  �  �  

Load fonts on the fly �  �  �  �  

     

Drawing     

Bezier �  �  �  �  

Freehand drawing �  �  �  �  

Zoom to cursor �  �  �  �  
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Shapes     

Rectangle �  �  �  �  

Oval �  �  �  �  

Polygon �  �    

Starburst �  �    

Fan �     

Arrow �     

Border tool �  �    

Registration mark tool �  �  �  �  

Eyedropper �     

Measure tool �  �  �  �  

     

Path Editing     

Select Point Tool �  �  �  �  

Remove point �  �  �   

add point �  �  �   

straighten path �  �  �   

Round corner �  �  �   

Sharpen Corner �  �  �   

Optimize by Curve �  �  �   

Optimize by smooth 

arc �  �  �   

Optimize by 3point arc �  �  �   

Make Arc �  �  �   

Reduce Points �  �  �   

Close path �  �  �   

Change Start Point �  �  �   

Cleaver �  �  �   

Scissors �  �  �   

Make right angle �  �  �   

Break path �  �  �   

Join paths �  �  �   

Align horizontal �  �  �   

Align vertical �  �  �   

Align Paths �  �  �   

Apply Length and 

Angle �  �  �   
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Remove tiny objects �  �  �   

     

Working with Files     

Job Info �  �  �   

Scanning �  �  �   

Send email as jpg �  �    

send email as pdf �  �    

send email as native �  �  �  �  

Workspaces �  �  �  �  

     

View     

Design Editor �  �    

Color mixer �  �  �  �  

Snap �  �  �  �  

     

Arrange     

Group �  �  �  �  

Compound �  �  �  �  

Mask �  �  �  �  

Lock �  �    

Guides �  �  �  �  

Contour Cut �  �  �  �  

Dimension �  �    

Convert to outlines �  �  �  �  

convert linked to native �  �  �  �  

Path direction �  �  �  �  

Order �  �  �  �  

Align �  �  �  �  

Distribute �     

Step and Repeat �  �  �   

     

Effects     

Combine �  �  �   

Outline �  �  �   

Contour Cut �  �  �  �  

Distort �  �    

Shadow �  �  �   
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Color Trapping �     

Smooth shadow �  �  �   

     

Bitmap     

Marquee �  �    

Move �  �    

Eraser �  �    

Pencil �  �    

Fill �  �    

Crop �  �    

Autotrace �  �    

Color Trace �     

Change Color Mode �     

     

Production      

Cut/Plot �  �  �  �  

Manual Split Lines �  �  �  �  

Tile all copies �  �  �  �  

Panel to border �  �  �  �  

Autoweld �  �  �  �  

Auto trap �  �  �  �  

Overcut �  �  �  �  

Optimize cutting order �  �  �  �  
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DirectCut Mac AI Plug-in is compatible with MAC OS X 10.4-10.7 (operated with Adobe 

Illustrator CS2-CS5). 

If you want to use Adobe Illustrator CS6 on your MAC, you may need Parallels Desktop 

software, Window OS and Windows based Adobe Illustrator CS6 to install Windows OS in your 

MAC computer and run Windows based software under MAC computer. 

User Instructions  

Follow the simple steps below to complete your output settings: 

Step 1. Run DirectCut  

1) Go to File and select “Show DirectCut Tools” under “DirectCut” 
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You will be presented with this dialog below: 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Step 2. Create/ import your image/ file.  
For texts 
1) Enter your texts in Adobe Illustrator, select the letters and click [Text outline] to outline the 
letters. 

 
 
 
 
 
                  

A contour line will be created for your image. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Note: The line width must be set as 0.001 mm 
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For Images 

1) Open a new image on Illustrator and decide the size of your material. 

 
 

2) Select the image and click [Make outline and offset] to create outlines of graphics. 
 
 
 

 

 

 

 

 

 

 

Outlines will be created for your image. 
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3) Click on the image and apply the AAS function by clicking the [Add registration marks] 
command and select the registration marks needed.  
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
The registration marks will be created as below. 

 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 



 
                                                      Expert 52 LX user manual 

 

DriectCut                                      A-7 

Step 3. Output  

1) Click on [Plotter Setup] and select the correct model in [Plotter List]. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2) Tick Default Environment to create Pen No.1 in the Pen section. Double click Pen No.1 and 

complete your parameter settings. 
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3) Select the entire object and click [Plotter Output]. 

 

 

 

 

 

 

 

 

 

4) Output the object by clicking [Export] and GCC Cutting Plotter will start cutting the image. 

 

 
 
 
 
 
 
 
 

 


